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COPYRIGHT © 2011, 2016  Pennington Publishing 
  
NOTICE TO THE READER 
 
 All rights reserved Pennington Publishing 2011. Permission is hereby 
granted to the individual purchaser to reproduce student materials in this book for 
noncommercial individual or classroom use only. Purchase of The Pennington Manual 
of Style grants you, the purchaser, and your students full license to use these resources 
at school and at home.  
  
Material from this book has been previously published in the author’s Teaching Essay 
Strategies © 2001, 2011, Grammar, Usage, Spelling, and Mechanics © 2013, Teaching 
Grammar and Mechanics © 2003, 2011, and Teaching Reading Strategies © 2008. 
These curricula are available for purchase at www.penningtonpublishing.com. 
  
Other than the heretofore specified limited permission for reproduction, the text of this 
publication, or any part thereof, may not be reproduced or transmitted in any form or by 
any means, electronics or mechanical, including photocopying, recording, storage in an 
information retrieval system, or otherwise, without prior written permission of the 
publisher. 
  
The Publisher makes no representation or warranties of any kind, including but not 
limited to, the warranties of fitness for particular purpose or merchantability, nor are 
any such representations implied with respect to the material set forth herein, and the 
publisher takes no responsibility with respect to such material. The publisher shall not 
be liable for any special, consequential, or exemplary damages resulting, in whole or 
part, for the readers’ or students’ reliance upon, this material. 
 
Curricula Designed to Teach the Essay e-Comments Content 
 
The Essay e-Comments have been derived from the following comprehensive curricula: 
Teaching Essay Strategies, Grammar, Usage, Spelling, and Mechanics, 
Teaching Grammar and Mechanics, and Teaching Reading Strategies and 
are available at www.penningtonpublishing.com. Each curriculum uses the same 
language of instruction as does The Pennington Manual of Style. Each curriculum 
provides diagnostic assessments to determine the individual needs of students in 
writing, spelling, grammar, mechanics, and reading. Each curriculum provides targeted 
worksheets with formative assessments and activities to enable the teacher to 
differentiate instruction.  
 
 
 



The Pennington Manual of Style © 2016 Pennington Publishing www.penningtonpublishing.com  2 
 

Table of Contents 
 
Writing Tips and Essay e-Comments     Page #s 
 
Essay Organization and Development:  
Introduction, Body, and Conclusion (e1—e49) 
 
Introduction Paragraphs        7-9 
Body Paragraphs: Argument, Analysis, Evidence    9-12 
Conclusion Paragraphs        12 
 
Coherence, Word Choice, Sentence Variety, and Writing Style (e50—e101) 
 
Coherence           12-13 
Word Choice          14 
Sentence Variety         14   
Writing Style          15-17 
 
Format and Citations (e102—e135)      18-20 
 
Parts of Speech, Grammatical Forms, Usage (e136—e267) 
 
Nouns           21 
Pronouns          22-25 
Adjectives          25-27 
Verbs           27-31 
Adverbs          31-32 
Modifiers          33 
Prepositions          34 
Conjunctions          34 
 
Sentence Structure and Types of Sentences (e268—e293) 
 
Subjects and Predicates        35-36 
Types of Sentences         36-37 
 
Mechanics (e294—e402) 
 
Commas          38-40 
Capitalization         40-42 
Quotation Marks, Italicizing, Underlining     43-45 
Additional Punctuation        46-48 
 
Conventional Spelling Rules (e403—e438)    49-51 
 
Quick Reference Guide (e403—e438)     52-62 
 



The Pennington Manual of Style © 2016 Pennington Publishing www.penningtonpublishing.com  3 
 

Introduction 
 
The Pennington Manual of Style has been designed to serve both students and teachers.  
  
The user-friendly The Pennington Manual of Style provides 438 writing tips. Each 
writing tip has a concise definition, explanation, and a clear example. Writing tips are 
organized into these categories: Essay Organization and Development (Introduction, 
Body, and Conclusion), Coherence, Word Choice, Sentence Variety, Writing Style, 
Format and Citations, Parts of Speech, Grammatical Forms, Usage, Sentence Structure, 
Types of Sentences, Mechanics, and Conventional Spelling Rules. As a quick reference 
guide, this style manual will help developing writers learn what is correct and why it is 
correct.  
  
For teachers, this guide will provide a common language of writing instruction and 
discourse for teachers and students. Teachers will find the concise writing tips useful for 
both direct instruction and essay comments. And most importantly, all 438 writing tips 
have been formatted as Essay e-Comments for the Autocorrect function of Microsoft 
Word®. After adding in the comment bank, the teacher simply types in the assigned 
alphanumeric code and the entire formatted writing comment appears where desired on 
the student’s Word document or on a printed comments page.  
 
Using Essay e-Comments Makes Sense  
  

 Manually responding to essays in red ink can be time-consuming and frustrating. 
Teachers find themselves using the same comments over and over again, while 
most students barely glance at their final grade or rubric score and maybe skim 
the comments before cramming their papers into the depths of their backpacks.  

 Using Essay e-Comments will save time. Most teachers can respond to and/or 
evaluate essays in half the time it takes to manually correct. 

 Using Essay e-Comments simply does a better job than manual correction. Each 
comment has a definition, explanation, and example to help students learn what 
is correct and why it is correct. And teachers can certainly add in their own 
comments. Unlike other e-grading programs, teachers can save their custom 
comments.  

 Having students submit their essays on the computer allows the teacher to insert 
comprehensive and prescriptive comments into their Microsoft Word® 
documents. Teachers can require their students to address each comment by 
using Microsoft Word® “Track Changes.” Students then re-submit revisions and 
edits for peer and/or teacher review. Just like real professional writers do with 
their editors!  

 Teachers can select and print out Essay e-Comments for paper submissions to 
provide response/editing feedback and/or to supplement an evaluative rubric. 

 Using the 438 e-comments enhances the interactive writing process. The teacher-
student interaction changes from static summative evaluation to dynamic 
formative assessment.  
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How to Insert Essay e-Comments into Microsoft Word® Docs 
 
1. Click on this link to download all 438 Essay e-Comments:  
h p://blog.penningtonpublishing.com/wp-content/uploads/2015/12/Autocorrects.exe    
Save if prompted and click RUN despite the scary Microsoft warning that it doesn’t 
recognize the software. Don’t worry: This program is virus-free. The download has 
been tested for Microsoft Word® 2003, 2007, 2010, 2013, 2016 (Windows XP, 
Vista, and Win 7, 8, and 10. The program works fine with Google docs. Simply batch 
download into Word®, open the docs in Word® and insert the comments. Upload 
back to Google docs, if you wish, and maintain the comments. 
 
2. Open up a student’s essay in Microsoft Word®. Use the Quick Reference Guide 
with the alphanumeric entry codes and a short comment description, to guide your 
essay e-comment selection. The Quick Reference Guide organizes the essay e-
comments into writing response categories. Highlight the ones you use most often. 
 
3. Go to the Review tab in the Comments group. Left click the mouse where you 
want to place a comment. Click the New Comment image. In older Microsoft 
Word® versions, go to the Insert tab and then to Comments. 
 

 
 
4. The comment balloon will appear in the right margin or in a reviewing pane at the 
bottom of the screen or to the left of the screen. Adjust the comment location under 
Reviewing Pane in the Track Changes group. The keyboard shortcut to include a 
new comment is Ctrl + Alt + M. 
 
5. Type in the alphanumeric code for the selected essay e-comment and full comment 
appears in the comment balloon or where you decide is best. 
 

 
 
6. For repeated errors, simply highlight the text. The yellow marker is found under 
the “Home” tab. Of course, not every error need be marked. Consider using a balance 
of content and process essay e-comments, depending upon the instructional focus 
and the needs of each writer. 
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7. You can also personalize comments by adding to the comment balloons. You can 
even add audio comments to summarize overall strengths and weaknesses. To add an 
audio file (Sound Recorder) into Microsoft Word®, open Start; open All 
Programs; open Accessories; then open Sound Recorder. Click the button to 
start and stop recording. The Save menu will pop open and you can create a folder 
to save all of your audio files. Once saved, open up the folder and right click to copy 
the WMA file. Place your cursor where you want the file to appear in the student’s 
essay and paste Ctrl + V. The Sound Recorder file stays minimized as you open up 
other Microsoft Word® files, so you don’t have to go through the process each time. 
For better sound quality, I suggest using a microphone. 
 
8. Teach your students to revise and edit their documents in response to your essay 
e-comments. I suggest using Microsoft Word® Track Changes. Teach your 
students to go the Review tab and click on Track Changes, then revise and edit 
their document by inserting, deleting, moving, or formatting text. The resources in 
Change Tracking Options provide custom color and formatting options. The 
keyboard shortcut to turn on Track Changes is Ctrl + Shift + E. 
 

How to Add Your Own Permanent Autocorrect Entries in 
Microsoft Word® 
 
1. You can add your own e-comments onto the 438 essay e-comments bank. Here’s 
how: Type your e-comment. The text can include up to 255 characters of hyperlinks, 
different fonts, colors, italics, boldface, etc. Highlight the e-comment, but don’t copy 
it. 
 
2. Click the Microsoft Word® 2010 File. Then click Options. Next click Proofing. 
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3. With previous Microsoft Office® versions (before 2010), click File. Then click 
Word Options. Next click Proofing. 
 

 

 

4. Now click AutoCorrect Options. This page is similar in all recent Microsoft 
Word® versions. The highlighted text will appear within the With: text box.  
 
5. Enter an alpha-numerical code in the Replace: text box and click OK. 
 

 

6. Your own essay e-comment is now permanently saved on your computer. I suggest 
that you save all of your additional e-comments in a Microsoft Word® document so 
that you can easily add these on to other computers.  

 
 

Here is where the highlighted text appears. 



The Pennington Manual of Style © 2016 Pennington Publishing www.penningtonpublishing.com  7 
 

Essay Writing Tips (formatted as Essay e-Comments) 
 
Students: 
 
A style manual is a writer’s reference guide. This guide is designed to help you write 
better essays and research papers. Following are 438 writing tips to help you do just 
that. Each writing tip has a concise definition, explanation, and a clear example. Writing 
tips are organized into these categories: Essay Organization and Development 
(Introduction, Body, and Conclusion), Coherence, Word Choice, Sentence Variety, 
Writing Style, Format and Citations, Parts of Speech, Grammatical Forms, Usage, 
Sentence Structure, Types of Sentences, Mechanics, and Conventional Spelling Rules. 
 
The alphanumeric listings are coded so that your teacher can easily insert these 
comments into Microsoft Word® documents and/or onto printed comment pages. Your 
teacher may ask you to use the comments to respond to writing completed by your 
peers.  
 
Your teacher may not choose to comment on every writing error or issue. However, if 
your teacher does include a comment, do your best to revise your writing accordingly 
and make a mental note, or better yet an actual note, to learn the writing terms and 
rules to apply on future writing assignments. 
 
Mark Pennington 
 
 
 
Body Paragraphs: Argument, Analysis, Evidence 
  
e17 Needs Topic Sentence If a topic sentence is not stated, it must be clearly implied 
(suggested). This paragraph states details, but not the main idea. Most topic sentences 
are placed as the first sentences in body paragraphs. 
  
e18 Needs Concluding Statement Not every body paragraph requires a concluding 
statement; however, this lengthy paragraph does to re-connect your reader to the topic 
sentence and provide an effective transition to the next paragraph. 
  
e19 Delete Concluding Statement Not every body paragraph requires a concluding 
statement. This concluding statement is redundant (repetitive) and unnecessary. It is 
not needed to transition to the next paragraph.  
  
e20 Major Details Not of Same Content Category Major details used to support 
the main idea of the topic sentence need to be of the same content category.                   
Example: Topic Sentence Main Idea=weather Major Details=rain, nice  
Revisions: Topic Sentence Main Idea=weather Major Details=rain, snow (not nice) 
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e21 Major Details Not of Same Hierarchical Importance Major details used to 
support the main idea of the topic sentence need to be of the same hierarchical      
importance. Example: Topic Sentence: Democracy is essential. Major 
Details=equality, it’s fun to vote Revision: equality, protection of liberties 
  
e22 Minor detail does not relate to major detail. This minor detail is either off 
topic or doesn’t directly relate to the major detail it intends to support. 
 
e23 Sequence Problem This sentence is improperly placed and so confuses the 
reader. Re-read the paragraph to determine proper placement or delete if it does not fit 
in to the flow of the paragraph. Common idea sequences include the following: general 
to specific, chronological order, cause to effect. 
 
e24 Inadequate Development The main idea of the topic sentence requires further 
evidence to adequately inform or convince the reader. Add evidence such as Fact, 
Example, Statistic, Comparison, Quote from an Authority, Logic, Experience, or 
Counter-Argument/Refutation. FE SCALE C 
  
e25 Irrelevant The point may be valid on its own but it does not specifically address the 
purpose or point of view of the essay. Either delete or revise to clarify how it is      
meaningfully and appropriately related.  
  
e26 Add Support Evidence More evidence is needed to adequately support your topic 
sentence. Add evidence in major detail or minor detail sentences such as Fact,          
Example,  Statistic, Comparison, Quote from an Authority, Logic, Experience, or 
Counter-Argument/Refutation. FE SCALE C 
  
e27 Support Evidence Variety The main idea of the   topic sentence would be better 
explained or proven with greater variety of evidence. Add additional evidence such as 
Fact, Example, Statistic, Comparison, Quote from an Authority, Logic, Experience, or 
Counter-Argument/Refutation. FE SCALE C 
  
e28 Define Terms or Special Words This term or word is not commonly understood 
or is used in a special way and so should be defined to be courteous to the reader. 
Italicize or underline the term or word. The definition can be parenthetical or stand on 
its own. Example: The zeitgeist (spirit of the times)… 
  
e29 Get more specific. The support evidence is too general. Add more specific 
evidence by including Fact, Example, Statistic, Comparison, Quote from an Authority, 
Logic, Experience, or Counter-Argument/Refutation. FE SCALE C 
  
e30 Off Topic Focus is off the controlling idea. The point is off topic and should be 
deleted or revised to clarify how it is on topic. 
  


